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TC-2190 ApAPTER WITH THERMOCOUPLE
MiniconNECTORS INSTALLATION GUIDE

This installation guide describes how to install and connect thermocouples
and digital I/O signals to the TC-2190 adapter with thermocouple
miniconnectors to use with the NI USB-4350, NI PXI-4351, and

NI PCI-4351 data acquisition (DAQ) devices.

Introduction

The TC-2190 adapter consists of a shielded box with 14 miniconnectors
that you can use to connect the thermocouples to the NI 435X for USB,
PXI, and PCI. This adapter has two 68-pin connectors—one on the front
and one on the rear. You can use either of the two connectors to connect the
TC-2190 to the NI 435X using an SH6868 shielded cable (recommended)
or an R6868 ribbon cable. You can also access the eight digital I/O lines
and the digital ground of the NI 435X using the spring terminal blocks.

This adapter is designed specifically for ease of use with thermocouples.
It features isothermal construction to minimize the temperature gradients
across the thermocouple junctions and a high-accuracy thermistor
cold-junction temperature sensor.

The TC-2190 connects to all the digital I/O lines on the NI 435X and all but
two analog input channels (CH)—CHO is dedicated to the cold-junction
sensor and CH1 is dedicated to auto-zeroing circuitry. Refer to the

NI 435X User Manual for further details on the cold-junction sensor and
auto-zeroing circuitry.

Conventions

The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

National Instruments™, NI™, ni.com™, and NI-DAQ™ are trademarks of National Instruments Corporation. Product and October 2002
company names mentioned herein are trademarks or trade names of their respective companies. For patents covering 321674C-01
National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents. txt file

onyour GD, or ni .com/patents.
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bold

italic

monospace

NI 435X

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

Refers to all devices in the National Instruments 4350 and 4351 families.

What You Need to Get Started

You need the following items to set up and use the TC-2190:
U TC-2190 adapter with thermocouple miniconnectors

QO  7C-2190 Adapter with Thermocouple Miniconnectors Installation
Guide

U Read Me First: Safety and Radio-Frequency Interference

U

NI PCI-4351, NI PXI-4351, or NI USB-4350 and documentation

U One of the following cable assemblies:
— SH6868 shielded cable (recommended)
— R6868 ribbon cable

U  1/8 in. flathead screwdriver

(]

Number 1 Phillips screwdriver

U Wire cutters

TC-2190 Adapter Installation Guide 2 ni.com



U Wire insulation strippers

U Four adhesive rubber feet

Configuring the Shield Ground Jumpers

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

Jumper W1, located inside the TC-2190 on the bottom of the board,
connects the shield of the 68-pin connectors and the TC-2190 metal case to
NI 435X ground through a 100 € resistor (default setting) or directly to
NI 435X ground, or keeps the metal case and NI 435X ground separate.

Table 1 shows the configuration options for jumper W1.

@ Note Use the default setting for jumper W1 unless you notice degraded noise
performance.

© National Instruments Corporation 3 TC-2190 Adapter Installation Guide



Table 1. TC-2190 Jumper Configuration Options

Jumper W1
Configuration Description When to Use This Configuration
100 Q (factory default)—This | Use this setting when you are using
setting connects the TC-2190 | the SH6868 cable, and:
— OPEN metal chassis to NI 435X * You have not rack-mounted the
1000 grqund thrqugh a 190 Q TC-2190, or
resistor, while keeping any * You have mounted the TC-2190 on
—oQ potential ground loop current a rack, but are unsure whether the
very small. rack and the TC-2190 are
grounded.
0 Q—This setting connects Use this setting when you are using
the TC-2190 metal chassis to the R6868 cable, and:
— OPEN NI 435X ground. * You have not rack-mounted the
— 100 Q TC-2190, or
* You have mounted the TC-2190 on
—oQ arack and are sure that the rack and
the TC-2190 are not grounded.
Open—This setting Use this setting when you are using
disconnects the TC-2190 either the SH6868 cable or the
— OPEN metal chassis from NI 435X R6868 cable, and:
1000 ground. * You have mounted the TC-2190 on
arack, and
—oQ * You are sure that the rack and the
TC-2190 are grounded.

If you need to change jumper W1, refer to Figure 1 as you complete the
following steps:

1.

AR

TC-2190 Adapter Installation Guide

Using the Number 1 Phillips screwdriver, remove the four countersunk

front panel screws.

Remove the two rear panel screws that hold the rear 68-pin connector.

Hold the front panel and slide the assembly out of the metal case.

Set jumper W1 as needed.

Reassemble the TC-2190, following this procedure in reverse order.

Do not overtighten the screws.

ni.com



1 Rear Panel Screws 4 Sprint Terminal Blocks 6 Thermocouple Miniconnectors
2 Jumper W1 5 Front 68-Pin Connector 7 Rear 68-Pin Connector
3 Countersunk Front Panel Screws

Figure 1. TC-2190 Parts Locator Diagram

Connecting the Signals

Refer to the NI 435X User Manual for examples on how to connect to the
signals.

Connecting Thermocouples

Insert the thermocouple miniconnector to the mating miniconnector on the
TC-2190. Each miniconnector is keyed; that is, it has two spades of
different widths so that you can insert the thermocouple in only one way.

Do not force the miniconnector. If you encounter difficulty while inserting
the miniconnector, check whether the polarity is correct.

© National Instruments Corporation 5 TC-2190 Adapter Installation Guide



Connecting Digital 1/0 Signals

Refer to Figure 1 as you complete the following steps to connect the digital
signals to the TC-2190:

1.

4.

Use a wire cutter and wire insulation stripper to strip the wire ends
as necessary to connect them to terminal blocks. You can use up to
20 AWG wire for connecting signals.

Push the spring below the DIO terminal block with a 1/8 in. flathead
screwdriver to open the terminal block clasp. Keep the spring pressed
through step 3.

Insert the stripped wires into the terminal blocks.

Release the spring.

The wire should be firmly connected.

Connecting the TC-2190 to the NI 435X

Before installing the TC-2190, make sure you have set jumper W1
correctly for the application.

You can mount the TC-2190 into a 19 in. rack or place it on a workbench
near the NI 435X. If you do not rack-mount the TC-2190, attach the four
adhesive rubber feet included in this kit to the TC-2190 to keep it stationary.

@ Note To minimize the temperature gradient inside the terminal block and thus maintain its
isothermal nature for accurate cold-junction compensation, place the accessory away from
extreme temperature differentials.

Refer to Figure 2 as you complete the following steps to connect the
TC-2190 to the NI 435X:

1.

Connect one end of the SH6868 or R6868 cable to the TC-2190
connector on either the front or the back, as desired. The two
connectors should snap together.

Attach the connector on the other end of the SH6868 or R6868 cable
to the NI 435X I/O connector.

To disconnect the cable from the TC-2190, push the two ejector ears on the
cable backshell and gently pull on the backshell. The cable should pop out.
Do not pull the cable.

A Caution The connectors of both the TC-2190 and the NI 435X are keyed. Do not force the
cable. If you encounter difficulty, check whether the polarity is correct.

TC-2190 Adapter Installation Guide
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Front View

Rear View

TC-2190

Front Panel

Front 68-Pin Connector
Ejector Ears

SH6868 Shielded Cable

NI 435X for USB, PXI, and PCI
Rear Panel

Rear 68-Pin Connector
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Figure 2. Connecting the TC-2190 to the NI 435X
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Cold-Junction Temperature Sensor

The TC-2190 cold-junction temperature sensor consists of a precision
thermistor excited by the 25 pA current source on the NI 435X. At 25 °C,
the resistance of the thermistor is 5,000 Q. The thermistor resistance varies
from 16,305 to 1,492 Q over the 0 to 55 °C temperature range. The
corresponding sensor output voltage varies from 408 to 37 mV over this
temperature range.

To select and measure the temperature sensor, refer to the data acquisition
software documentation for programming information.

Alternatively, you can use the following formulas to convert the
cold-junction sensor voltage to cold-junction temperature:

T(°C) =Tg—273.15
where Ty is the temperature in Kelvin.

1

Ty = .
a+belnR,+ce(InR,)

a=1.295361x 103
b =2.343159 x 10~
¢ =1.018703 x 107

Ry =resistance of the thermistor in ohms

T(°C)e9

T(F) = ==

32

where T(°F) and T(°C) are the temperature readings in degrees Fahrenheit
and degrees Celsius, respectively.

@ Note When you have configured the NI 435X DAQ device with the correct accessory in

Measurement & Automation Explorer, NI-DAQ can automatically perform cold-junction
compensation on measurements taken on thermocouple channels.

TC-2190 Adapter Installation Guide 8 ni.com



Specifications

Cold-junction sensor accuracyl.............. 0.06 °C from 15 to 35 °C;
0.2 °C from O to 15 °C
and 35 to 55 °C

Maximum working voltage?
(signal + common mode) .........cccceeeuennne Each input should remain
within +42 V of ground

Safety

The TC-2190 meets the requirements of the following standards for safety
and electrical equipment for measurement, control, and laboratory use:

« EN61010-1, IEC 61010-1
« UL3I121-1
 CAN/CSA C22.2 No. 1010.1

@ Note For UL and other safety certifications refer to the product label or to ni . com.

Electromagnetic Compatibility
CE, C-Tick, and FCC Part 15 (Class A) Compliant

Electromagnetic emissions..................... EN 55011, ISM Group 1,
Class A at 10 m
FCC Part 15A above 1 GHz

Electromagnetic immunity ..................... Evaluated to EN 61326-1;
A1:1998, Table 1

@ Note For full EMC compliance, you must operate this device with shielded cabling. In
addition, all covers and filler panels must be installed. Refer to the Read Me First: Safety

and Radio-Frequency Interference document for FCC Regulatory statements and related
information.

! Includes only the thermistor accuracy. The combined effects of the temperature sensor accuracy, as well as the current source
accuracy due to tolerances in all components in the NI 435X, the effects caused by temperature and loading, and self-heating
and current leakage are discussed in the NI 435X User Manual.

2 Refer to the NI 435X maximum working voltage specification in Appendix A, Specifications, of the NI 435X User Manual,
use the lower number of the two.
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CE Compliance

The TC-2190 meets the following amended essential requirements of
applicable European Directives for CE marking:

*  Low-Voltage Directive (safety): 73/23/EEC
*  Electromagnetic Compatibility Directive (EMC): 89/336/EEC

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, click Declaration
of Conformity at ni . com/hardref .nsf/. This Web site lists the DoCs by product
family. Select the appropriate product family, followed by the product, and a link appears
to the DoC in Adobe Acrobat format. Click the Acrobat icon to download or read the DoC.

Technical Support Resources

NI Web Support

NI Web support is your first stop for help in solving installation,
configuration, and application problems and questions. Online
problem-solving and diagnostic resources include frequently asked
questions, knowledge bases, product-specific troubleshooting wizards,
manuals, drivers, software updates, and more. Web support is available
through the Technical Support section of ni . com.

Worldwide Support

National Instruments has offices located around the world to help address
your support needs. You can access our branch office Web sites from the
Worldwide Offices section of ni . com. Branch office Web sites provide
up-to-date contact information, support phone numbers, email addresses,
and current events.

If you have searched the technical support resources on our Web site

and still cannot find the answers you need, contact your local office or
National Instruments corporate. For telephone support in the United States,
dial 512 795 8248. For telephone support outside the United States, contact
your local branch office:

Australia 03 9879 5166, Austria 0662 45 79 90 0, Belgium 02 757 00 20,
Brazil 55 11 3262 3599, Canada (Calgary) 403 274 9391,

Canada (Montreal) 514 288 5722, Canada (Ottawa) 613 233 5949,
Canada (Québec) 514 694 8521, Canada (Toronto) 905 785 0085,

China 86 21 6555 7838, Czech Republic 02 2423 5774,

Denmark 45 76 26 00, Finland 09 725 725 11, France 01 48 14 24 24,
Germany 089 741 31 30, Greece 01 42 96 427, Hong Kong 2645 3186,
India 91 80 4190000, Israel 03 6393737, Italy 02 413091,

TC-2190 Adapter Installation Guide 10 ni.com



Japan 03 5472 2970, Korea 02 3451 3400, Malaysia 603 9596711,
Mexico 001 800 010 0793, Netherlands 0348 433466,

New Zealand 09 914 0488, Norway 32 27 73 00, Poland 22 3390 150,
Portugal 210 311 210, Russia 095 238 7139, Singapore 65 6 226 5886,
Slovenia 3 425 4200, South Africa 11 805 8197, Spain 91 640 0085,
Sweden 08 587 895 00, Switzerland 056 200 51 51,

Taiwan 02 2528 7227, United Kingdom 01635 523545
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